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1. Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen.Tag den tid du
behgver for at laese vejledningen, inden du bruger
skeermen. Den indeholder vigtige oplysninger om

bemazrkninger angaende brugen af din skaerm.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

) Advarsler

Anvendelse af kontrolelementer, justeringer eller
fremgangsmader, der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker:
Lees og felg disse vejledninger; nar du tilslutter og
anvender din computerskaerm:

Betjening:

»  Skaermen skal holdes veek fra direkte sollys,
savel som meget kraftigt lys og andre
varmekilder: Leengere udseettelse for disse
typer omgivelser kan medfere affarvning og
beskadige skaermen.

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkeling af skeermens elektronik.

* Bloker ikke ventilationshullerne pa kabinettet.

* Ved placering af skaeermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Huvis der slukkes for skaermen ved at fierne
stremkablet eller jeevnstremsledningen, skal du
vente 6 sekunder; for du saetter stremkablet
eller javnstremsledningen til igen for at opna
normal betjening.

*  Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

»  Udsat ikke skaermen for kraftige vibrationer
eller stad under anvendelse.

*  Sla ikke pa skeermen, og tab den ikke under
brug eller transport.

Vedligeholdelse:

* Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa skeermpanelet. Nar du
flytter din skaerm, sa tag fat om rammen for at
lzfte den; laft ikke skeermen ved at satte din
hand eller fingre pa skeermpanelet.

*  Tag stikket ud fra skeermen, hvis du ikke skal
bruge den i en leengere periode.

* Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skaermen kan tgrres af med en tar klud,
nar der er slukket for stremmen. Under alle
omstendigheder, ma der ikke bruges organiske
oplgsningsmidler til renggring af din skaerm.

*  For at undga risiko for elektrisk sted eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skeermen for stev, regn, vand eller
miljiger med hgj fugtighed.

*  Huvis din skaem bliver vad, skal den tgrres af
med en ter klud sa hurtigt som muligt.

*  Hvis der kommer fremmed substans eller vand
ind i skeermen, s sluk straks for stremmen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.

*  Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse af din
skeerm og for langvarig brug, sa brug skeermen
et sted, der er indenfor felgende temperatur-
og fugtighedsomrade.

o Temperatur: 0-40°C 32-95°F
o Fugtighed: 20-80% RH



Vlgtlge oplysninger om burn in/skyggebillede
Serg altid for at aktivere en pauseskarm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskarm eller et andet program, der
opdaterer skeermen regelmassigt, hvis du
viser statisk materiale i leengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“breendes fast” pa skaermen, dvs. de sakaldte
“spogelsesbilleder” pa din skaerm.

* Fastbreending” og "spegelsesbilleder”
er velkendte fenomener inden for
skeermpanel-teknologien. “Fastbrending” og
“"spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaermen er slukket.

) Advarsel

Huvis du ikke aktiverer pauseskermen eller
regelmeessigt opdaterer skeermbilledet kan det
medfere symptomer pa “burn-in", “after-image”
eller “skyggebillede”, der ikke forsvinder og ikke
kan repareres. Ovennaevnte skader er ikke daekket
af garantien.

Service

» Kabinettet ma kun abnes af kvalificeret
servicepersonale.

* Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
"Kundeinformationscenter")

* For oplysninger om transport, se "Tekniske
specifikationer”.

» Efterlad ikke din skaerm i en bil/bagagerum
under direkte sollys.

& Bemzrkning

Kontakt en servicetekniker; hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa, hvad
du skal gare, nar betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke vaere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemaerkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler. De anvendes som falger:

© Bemarkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

© Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

) Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgds.

Visse advarsler kan optreede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sadanne
tilfelde er den givne udformning af advarslen
lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit wwwi.philips.com/about/sustainability/recycling.



E1 |Installation af stander

2. Opsatning af skaeerm

1. Anbring skeermen med forsiden vendt nedad

21 Installation pa en blad og jeevn overflade, og veer forsigtig
' med ikke at ridse eller beskadige skaermen.
El Emballagens indhold 2. Monter basesgjlen til monitoren, til den

klikker pa plads.

3.  Hold pa skaermens stander med begge
haender, og st med en fast hand standeren
ind i fodsgjlen.

VGA (optional) DVI (optional)




El Tilslutning til PC

PHILIPS

00000

AC strgmindgang

VGA-indgang

DVI-D input

Kensington anti-tyverisikring

Lydindgang (tilgeengelig i udvalgte modeller)

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skeermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skeermens
netledninger til et stik i neerheden.

Teend for computeren og skarmen. Hvis
skaermen viser et billede, er installationen
gennemfort.

2.2 Brug af skeerm

El Produktbeskrivelse set forfra

PHILPS 60000

220V3/220V3L
e
AUTO / W 0/ A Of < /0K [0)
| | / N\ |
(7] (6] o © O o
220V3A/220V3LA
e
Ao / W /A < /0K [0)
| | /\ |
(7] (6] o ©6 O o
@ O [|Forattende og slukke for skaermen.
O /0K |Sadan far du adgang til OSD-menuen.
@ d Gitilbage til det forrige OSD-niveau.
O & |Justérlysstyrkeniveauet.
© | A V¥V (Sidan justeresi OSD.
P o |Skift display-format.
1l |Tilindstilling af skaermens lydstyrke.
@ o |Juster monitoren automatisk.




F1 Beskrivelse af OSD-skarmen

Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display

(OSD)] er en funktion pa alle Philips skeerme.
Den satter en slutbruger i stand til at justere
skaermindstillingerne, eller veelge skaermens
funktioner direkte via et instruktionsvindue pa
skeermen. Et brugervenligt skeermvisningsinterface
vises som nedenfor:

220V3/220V3L

| VGA
L DVvI

Picture

olor

Language

220V3A/220V3LA

VGA
Input =

ﬂ Audio

Grundlzggende og enkle anvisninger til
kontrolknapperne

Pa OSD-skaermen, der er vist ovenfor, kan brugere
bruge w a-knapperne pa skaermens frontkant til at
bevaege cursoren med, OK for at bekrefte et valg

eller en eendring.

OSD-menuen

Nedenstaende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende den
som opslag, nar du senere skal orientere dig i de
forskellige justeringer.

Sub menu

[ VGA

DVI (available for selective models)

Main menu

— Input

Picture Format — Wide Screen, 4:3
— Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast — On, Off
L— Audio (available for selective models)
Stand-Alone —  On, Off

Mute On, Off

Color Temperature — 650K, 9300K
L Color E

sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
[— Language — English . Espafiol, Francais, Deutsch, ltaliano,

Portugués, Pycckuit, AL, Tirkce

r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 55,105,205,305,60s
— Sewp — Auto
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
[ Resolution Notification — On, Off
— Reset — Yes, No
L Information




El Meddelelse om opl@sning 2.3 Fjern standeren og foden

Denne skaerm er designet til optimal ydelse ved Kl Fjernelse af foden
dens naturlige oplasning: 1680%1050 ved 60Hz.
Nar skeermen bruger en anden oplgsning, ses
folgende advarsel pa skermen: Brug 1680%1050
ved 60Hz for at opnd det bedste resultat.

Inden du begynder at adskille skeermens stander,
skal du felge vejledningerne nedenfor for at undga
beskadigelse og personskade.

Adbvarslen vedrgrende den naturlige oplasning 1. Anbring skeermen med forsiden vendt nedad pa
kan deaktiveres under Setup (Installation) i OSD en jevn overflade, og var forsigtig med ikke at
(skeermmenuen). ridse eller beskadige skarmen.

Bl Fysisk funktion

Vip

2. Tryk pa laseclips for at fierne basestativet fra
basesgjlen.

3. Tryk pa frigerelsesknappen for at afmontere
basesgjlen.




E1 Fjernelse af foden

1. Du kan bruge en fladhovedet skrutreekker,
du stikker ind i de to udlgsningshuller pa
haengslets daeksel og forsigtigt lirke haengslets
deeksel for at fierne det.

2. Fjern de 4 skruer og fiern derefter foden fra
skeermen.




3. Billedoptimering

3.1 Smartimage Lite

El Hvad er dette?

Smartimage Lite er forudindstillede indstillinger;
der optimerer skaermen i henhold til indholdet, og
som indstiller den dynamiske lysstyrke, kontrast,
farve og skarphed i realtid. Uanset om du arbejder
med tekstprogrammer; ser billeder eller ser video,
sa giver Philips Smartlmage Lite den optimale
skaeermydelse.

E1 Hvorfor behgver jeg det?

Du gnsker en skeerm, som giver det bedste
billede for alle typer indhold. For at @ge skaerm-
oplevelsen, indstiller Smartlmage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed i
realtid.

El Hvordan virker det?

Smartlmage Lite er en eksklusiv, ferende Philips-
teknologi, som analyserer indholdet pa skeermen.
Ud fra det valgte scenarie forbedrer Smartimage
Lite dynamiske billeders og videoers kontrast,
farvemaethed og skarphed for at forbedre det
viste billede - alt i realtid og blot med et tryk pa
en knap.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen via
et nemt, grafisk interface. Komplicerede justeringer
herer fortiden til. Dette brugervenlige software
guider dig gennem finindstilling af oplgsning,
kalibrering af farve, justering af clockning/fase,
RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, og er tilmed
Windows 7 kompatibel, og klar til at forbedre din
oplevelse med Philips-skeermel!

Kl |Installation

* Felg instruktionen og fuldfer installationen.
Du kan starte, nar installationen er fuldfgrt.

* Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
vaerktgjslinjen.

PHILIPS

o philps.comiweicome

‘‘‘‘‘‘‘‘‘‘‘‘ P

Monitor driver and software installation




Opstartsguide
Efter installation af SmartControl Lite starter

guiden automatisk, nar du dbner programmet

forste gang.

F1 Start med Standard-vinduet:

Guiden leder dig trin for trin gennem

indstillingen af skeermen.

Du kan ogsa ga til Plug-in menuen, for at starte
guiden pa et senere tidspunkt. .
| Standard-vinduet kan du indstille flere .
funktioner uden brug af guiden.

8 smartcontrol

SmartControl Lite

]

Adiust Audio

Auto Prvot

i

-
Color Tnput

Wizard
2
resets

Muki Monitors

L 3

Help

2 phips 22581 (CS30715000001) ()
PHILIPS

Wizard

Youl need to calbrate your dsplay to get the most

tune your dplay and save the settings.

1. Choose the Start Wizard button.
2. Folow the steps outined in th process.
3. Save your settings for future use

Start Wiard

10

Adjust menu (Indstillingsmenu):

Med Adjust Menu (Indstillingsmenuen) kan

du indstille Brightness (Lysstyrken), Contrast
(Kontrast), Focus (Fokus), Position (Position)
og Resolution (Oplgsning).

Udfer indstillingen ved at felge instruktionerne.
Installationen kan annulleres med Cancel
(Annuller).

8 smartcontrol 2.- Philps 22581 (CS30715000001) ()X
SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil result n a loss of
detai n darker image areas. Adjust the Brightness for
the best possble picture quaity.
1. Lower the Brightness to the mnimum level.
2. Raise the Brightness to the desred level
3. Adust the Brightness as needed to achieve
3n equal separation of the strpes.

Brightness
o
Contrast
Color
A
Se Focus Brightness 100
Poston
Undo Reset.
optons o
! Resolution
Help
8 smartControl 2- Philps 22581 (€530715000001) {2},
SmartControl Lite PHILIPS
Contrast

Adjust the Contrast (use the sider) to keep detals n
ghter image areas.

1. Raise the Contrast unti the numbers 1 and 2
are no longer visble.

Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should reman barely visbe.

Brghtness

a @

Contrast
Color &
ol
| Foaus ntrast
— Contrast 50
= &
| Postcon
Optons undo Reset
Resolution

&

Help




8 smartcontrol

SmartControl Lite

Adjust Q
Brghtness
\’ Contrast
Color
- Focus
—
Postion
Options.
Resoltion

8 smartControl

SmartControl Lite

Adjust o)
. Brightness
Color
A
" s
_;
\g odbon
Options
Resolution

&

8 smartcontol

SmartControl Lite

ad

Brghtness
Contrast
Color AR
A
- Focus
s

\Q Postion

‘Options
! Resoluton

Help

2 - Philps 22581 (€$30715000001) (F]\%)
PHILIPS

Focus

Your display's timing needs to be synchronzed with
the video signal

1. Choose Auto Setup.

2. 1t verticlbands ae st visie, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brghtest setting to minimze
movement on the screen.

pech 50
o © &
Phase 17
o o &
Undn Auto SEDAD

2- Philps 22581 (C530715000001) (%1%

PHILIPS

Position

Use the Position buttons to center the mage o

your display. Usng this tool, you can postion the image
up, down, left, or rght.

Use the Up/Down buttons to center the image

ricaly
2. Use the Left/Right buttons to center the image
horzontaly.

undo Reset.

2. phips 22581 (cS30715000001) (ZX)

PHILIPS

Resolution

You re curent ot » refamed resoiton. Fo your
ay to show risp, clar text, colors, and images,

your display should be set to its Preferred resolution.

I your display s at 2 Non-Preferred resolution, cick

on the Preferred button to change your resolution to

Preferred

I™ Enable Resolution Notifer

Picture Format.
I™ 4:3 aspect ratio

Preferred

I

L

Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau), White
Point (Hvidpunkt), Display Gamma (Vis
gamma), Color Calibration (Farvekalibrering)
og Smartimage Lite (se afsnittet Smartlmage
Lite).

*  Udfer indstillingen ved at felge instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din indtastning.

*  Eksempel pa Color Calibration
(farvekalibrering)

2- Philps 22581 (€530715000001) (%)

PHILIPS

B smartControl
SmartControl Lite

Black Level
Improperly adiusted Black Level wil result i 2 loss of
detai n darker image areas. Adjust the Black Level for
the best possble picture qualy.
1. Adjust the biack level of the Red, Green, and
Blue using the sider bars.

n

RGB

a Red 50
Biack Level = +
Green 50
Color Whe Point = @ +
— Ble 50
Display Gamma = O &
b
undo Reset
optons Galbration
&p

Smartimage

Heip

2 - Phips 22581 (C$30715000001) {ZI\X)

PHILIPS

B Smartcontrol
SmartControl Lite

White Point

White Point is the point at which equal combinations
of red, green, and blue ight at ful ntensty create
white. This effects the overal color qualty. For the
most accurate colors clck the Reset buttan then
select the White Pont.

1. Please select the White Point value for the best

“! possble color qualty.
RGB
Color ‘whe Pont
Whte Paint 6500K
Display Gamma = O &
-l
iy B8 undo Reset
- ap
Smartimage

11



2-Philps 225B1 (CS30715000001) (2)X) |

PHILIPS

8 smartcontrol
SmartControl Lite

Display Gamma

Gamrma is 2 component of the pixel brightness in 2
display. A lower Gamima value produces brighter pixels
and a higher Gamma value produces darker pixes. The
defauk value for Gama & 2.2.

To adjust Gamma, Smartlmage must be set to O
Cick the Smartlmage Off button before adjustng
ma.

W

o

w
s

1. Use the sider to select the desred Gamma.

Coor waont Dispay Gama 22
= O @
Dispay Gamma Smartimage OFF
!
undo Reset
Options Calbration _—
ap
Smartimage
=
C
1 smarontor 2-Phups 22581 (CS30715000001) 5]\

PHILIPS

SmartControl Lite

Calibration

Your display nesds to be properly calibrated n order
for  to produce the wides: range of colors accurately.
Calibration should ahays take pace as the st tunng
step i the process. Remember to recalbrate any time
you make indivdual adjustments to image qualty or
whenever you move your dipay to 3 new location.

- Make 3l other necessary adjustments to image
frst

L

Adjust RGB 2. Press Show Me to leam how to use the
= aalibration took.
- " l 3. Finaly, press Start to begn the calibration
cess.
Lo W Enable color calbration

Color software designed n colaboration with Joseph
fomes

Color: Whte Point Protected by U.S. Patent lo. 6,696,953

Display Gamma

Show Me start

Quick View

"Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleser for/efter-
billederne.

For at vende tilbage til Color (Farve) vinduet,
skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan du
ikke udfgre en farvekalibrering, ligesom start-
og quick-visning knapperne er gratonede.
Der skal vaere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskaerm:

12

Previous (Foregaende) knappen er deaktiveret,
indtil du gar videre til den anden farveskarm.
Next (Neste) gdr til efterfalgende mal

(seks mal).

Final next (Afsluttende Neeste) gar til File >
Presets (File > Forvalg) vinduet.

Cancel (Annuller) lukker Ul og vender tilbage
til "plug in" siden.



Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Options (Funktioner)-
rullemenuen. P4 en ikke-understattet skaerm
med DDC/Ci er kun Help (Hjeelp) og Options
(Funktioner) til radighed.

8 smartControl 2- Philps 22581 (CS30715000001) \2)(X

SmartControl Lite PHILIPS

Preferences

&
d Q

Adjust. Audo

\5/ Auto Pot
-

Gobor ot

ot ‘kv
‘% 2

Options Presets

* Viser nuveerende, foretrukne indstillinger.

* Funktionen aktiveres ved at afmerke feltet.
Afmeerkningsfeltet er en flip-flop.

* Enable Context (Aktiver Indhold) menuen er
som standard afmarket (Til) pa skrivebordet.
Menuen Enable Context (Aktivér kontekst)
viser valgmulighederne i SmartControl Lite
pa Select Preset (Valg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke) menuen er

som standard afmaerket (Til) pa skrivebordet.
Menuen Enable Context (Aktiver Indhold)
gah, at systembakkens ikon til SmartControl
Lite vises. Et hgjreklik pad jobbakke-ikonen
viser menufunktionerne for Help (Hjalp) og
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).

* Run at Startup (Ker ved opstart) er
som standard afmeerket (Til). Nar den er
deaktiveret, starter SmartControl Lite ikke ved
opstart og ikonet vises ikke i systembakken.
SmartControl Lite kan kun startes fra genvejen
pa skrivebordet eller fra programfilen. Intet
forvalg, som er indstillet til at kere ved opstart,
indleeses nar denne boks ikke er afmaerket (er

deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows 7,Vista,
XP). Standard er 0% uigennemsigtighed.

"Options > Input" (Funktioner > Indgang) - er
kun aktiv, ndr Input (Indgang) er valgt i Options
(Funktioner) rullemenuen. Pa en ikke-understottet
skeerm med DDC/Ci er kun Help (Hjeelp) og
Options (Funktioner) til radighed. Alle andre
faneblade i SmartControl Lite er ikke til rddighed.

8 smatcontrol

SmartControl Lite

Options Presets

Help

2 - Phiips 22581 (CS30715000001) {3}, X.

PHILIPS

Analog In Digital In

*  Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger
* P& enkeltindgangsskeerme ses dette vindue

ikke.



Options > Audio (Funktioner > Lyd) - er

kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understettet skeerm med DDC/Ci
er kun Help (Hjaelp) og Options (Funktioner) til
radighed.

8 smartControl 2- Philps 22581 (€S30715000001) (2/\X)

SmartControl Lite PHILIPS
Audio

Adjust the Volume of the ntegrated loudspeakers by
using the sider.

Tum off the integrated loudspeakers by checkig the
Mute checkbox.

™ e
Adiust A ?,.,

i

Auto Pt

-

Color Input
o . k
\g ot
2
Options Presets.
\Q Wl aritors
voume 100
Hep =
undo

Help > User Manual (Hjeelp > Brugervejledning)
- er kun aktiv, nar User Manual (Brugervejledning)
ervalgt i Help (Hjeelp) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/Ci er kun Help
(Hjzelp) og Options (Funktioner) til radighed.

8 SmartControl 2 Phiips 22581 (€$30715000001) ()X

SmartControl Lite PHILIPS

User Manual
I you need heb setting up or operating SmartControl,

cick the Tech. Support button. You'l have the
option to fl out an Assstance Form.

You
soft

information about your
sstance

stomaticaly attache
iineed to be onine to use this feature.

]

Adiust p
=

Manual
P
e
Update
Color
a
- Dispby ID
2N
: System D
Options.
X
Verson

®

User Manual Tech. Support

Options > Version (Funktioner > Version) -
er kun aktiv, nar Version er valgt i Help (Hjeelp)
rullemenuen. P& en ikke-understattet skeerm
med DDC/Ci er kun Help (Hjelp) og Options
(Funktioner) til radighed.

B smartControl 2 - Philps 22581 (€530715000001) {2] (X,

SmartControl Lite PHILIPS

Version

ol
00 EVALUATION dtune-plp-R2009-12-17-

DDC/CI Communication: Yes - ATI2 APT

Copyright © 19932009 Portratt Dispays, Inc.

]

Adjust
User
&

9
update
a
osply
system >

Optons »‘s

Verson

5@ g A

Context Sensitive (Indholdssensitiv) menu
Context Sensitive (Indholdssensitiv) menuen

er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmarket i
Options > Preferences (Funktioner > Indstillinger)
vinduet, ses menuen.

D SmartControl
Select Preset L4
Tune Displacy
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Context menuen har fire punkter

SmartControl Lite - nar valgt, ses About (Om)
skaermen.

Select Preset (Velg Forvalgt) — herefter vises
en hierakisk menu med gemte forvalg, der
straks kan bruges. En afkrydsning viser det
nuveerende valgte forvalg. Factory Preset

(Fabriksforvalg) kan ogsa hentes i rullemenuen.

Tune Display (Indstil Skaerm) - abner
kontrolpanelet til SmartControl Lite.
Smartimage Lite - Kontroller nuveerende
indstillinger, Standard, Internet, Game (Spil).

Task Tray (Jobbakke) menu aktiveret

Menuen i systembakken kan ses ved at hgjreklikke
pa SmartControl Lite-ikonet i systembakken. Et
venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:
Abner Brugervejledningen med standard
browservinduet.

Technical Support (Teknisk Support) - viser
siden med teknisk support.

Check for Update (Tjek for opdateringer)

- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

Exit (Afslut) - Luk SmartControl Lite.

Help (Hjeelp) - adgang til brugervejledningsfilen:

Huvis du vil kere SmartControl Lite igen, skal du
enten valge SmartControl Lite i programmenuen,
dobbeltklikke pa skrivebordet eller genstarte
systemet.

PHILIPS

SmartControl

‘SmartControl
Version 320
dhune-standard-R2007-01-04-1151-23
Copyright 1993-2007 Portrat Dispiays, Inc.
Patents Pending

Task Tray (Jobbakke) menu deaktiveret

NaérTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun "EXIT" (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil fierne
SmartControl Lite fra systembakken, skal du
deaktivere Run at Startup (Ker ved opstart) i
Options > Preferences (Muligheder > Indstillinger).

© Bemarkning

Alle illustrationer i dette afsnit er kun

beregnet som reference. Softwareversionen af
SmartControl kan a@ndres uden varsel. Tjek altid
det officielle Portrait-websted www.portrait.com/
dtune/phl/enu/index for at downloade den seneste
softwareversion af SmartControl.
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4. Tekniske specifikationer

Skeermpanel-type

TF-LCD

Baggrundslys CCFL (220V3/220V3A), LED (220V3L/220V3LA)
Panelstgrrelse 55,9 cm (22")

Billedforhold 1610

Pixel pitch 0,282 x 0,282 mm

Lysstyrke 250 cd/m?

Smart-kontrast 10.000.000:1

Kontrastforhold (typisk) 1.000:1

Reaktionstid (typisk) 5ms

Optimal oplasning

1680x1050 ved 60Hz

Kinesisk, Portugisisk og Tyrkisk

Synsvinkel 160° (H) / 160° (V) ved C/R>10

Skaermfarver 16,/ M

Vertikal opdateringshastighed 56 -76 Hz

Horisontal frekvens 30 - 83 kHz

sRGB JA

Signalinput DVI-D (digital), VGA (analog)

Inputsignal Separat synk., synk. pa gren

Brugerfunktioner AUTO /W /A O /<4 /0K )
(220V3/220V3L)

Brugerfunktioner AUTO /W (/A G /< a2/ O
(220V3A/220V3LA)

OSD sprog Engelsk, Fransk, Tysk, Italiensk, Russisk, Spansk, Simplificeret

Andre funktioner

Kensington-las

"Plug & Play" kompatibilitet

Vip

DDC/CI, sRGB, Windows 7, Mac OSX, Linux

-5/+20
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Tendt-tilstand

22,63W (typisk), 26,51W (maks.)

Energiforbrug AC indgangsspaending | AC indgangsspaending | AC indgangsspeending

(EnergyStar 5.0 ved T00VAC +/-5VAC,| ved 115VAC +/-5VAC,| ved 230VAC +/-5VAC,

testmetode) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal funktion (typisk) | 20,61TW 2041W 19,85W

Sovetilstand (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab* AC indgangsspaending | AC indgangsspanding | AC indgangsspaending
ved 100VAC +/-5VAC,| 115VAC +/-5VAC, ved 230VAC +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal drift 70,35 BTU/t 69,67 BTU/t 67,75 BTU/t

Sovetilstand (Standby) 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Fra 1,706 BTU/t 1,706 BTU/t 1,706 BTUA

Power-indikator

Til-tilstand: Hvid, Standby/Sovetilstand: Hvid (blinker)

Stremforsyning

Teendt-tilstand

Indbygget, 100-240VAC, 50-60Hz

21,41W (typisk), 31,9W (maks.)

Energiforbrug AC indgangsspaending | AC indgangsspanding | AC indgangsspanding
(EnergyStar 5.0 ved T00VAC +/-5VAC,| ved 115VAC +/-5VAC,| ved 230VAC +/-5VAC,
testmetode) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal funktion (typisk) [ 20,00W 19,79W 19,50W

Sovetilstand (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab® AC indgangsspaending | AC indgangsspaending | AC indgangsspeending
ved 100VAC +/-5VAC,| 115VAC +/-5VAC, ved 230VAC +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal drift 68,25 BTU/t 67,54 BTU/t 66,55 BTU/t

Sovetilstand (Standby) 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Fra 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Power-indikator

Til-tilstand: Hvid, Standby/Sovetilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz
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Tendt-tilstand

19,59W (typisk), 24,15W (maks.)

Energiforbrug AC indgangsspaending | AC indgangsspanding | AC indgangsspeending

(EnergyStar 5.0 ved T00VAC +/-5VAC,| ved 115VAC +/-5VAC,| ved 230VAC +/-5VAC,

testmetode) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal funktion (typisk) | 16,72W 16,49W 16,24W

Sovetilstand (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab* AC indgangsspaending | AC indgangsspanding | AC indgangsspaending
ved 100VAC +/-5VAC,| 115VAC +/-5VAC, ved 230VAC +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal drift 57,08 BTU/t 56,26 BTU/t 5542 BTU/t

Sovetilstand (Standby) 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Fra 1,706 BTU/t 1,706 BTU/t 1,706 BTUA

Power-indikator

Til-tilstand: Hvid, Standby/Sovetilstand: Hvid (blinker)

Stremforsyning

Teendt-tilstand

Indbygget, 100-240VAC, 50-60Hz

18,54W (typisk), 28,03W (maks.)

Energiforbrug AC indgangsspaending | AC indgangsspanding | AC indgangsspanding
(EnergyStar 5.0 ved T00VAC +/-5VAC,| ved 115VAC +/-5VAC,| ved 230VAC +/-5VAC,
testmetode) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal funktion (typisk) [ 16,33W 16,19W 16,05W

Sovetilstand (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab® AC indgangsspaending | AC indgangsspaending | AC indgangsspeending
ved 100VAC +/-5VAC,| 115VAC +/-5VAC, ved 230VAC +/-5VAC,
50Hz +/- 5Hz 50Hz +/- S5Hz 50Hz +/-5Hz

Normal drift 55,72 BTU/t 55,26 BTU/t 54,79 BTU/t

Sovetilstand (Standby) 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Fra 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Power-indikator

Til-tilstand: Hvid, Standby/Sovetilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz
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Produkt med fod 530 x 425 x 213 mm
(BxHxD)
Produkt uden fod 530 x 364 x 53 mm
(BxHxD)
(Vee ]
Produkt med fod 3,81 kg
Produkt uden fod 3,51 kg

Produkt med emballage 4,32 kg

Temperaturomrade (drift) | 0°C til 40°C

Temperaturomrade -20°C til 60°C
(ikke i drift)
Relativ fugtighed 20% til 80%
Hejde Betjening: + 3.658 m
Ikke drift: + 12192 m
MTBF 30.000 timer
| Milomassige forhotd ]
ROHS JA
EPEAT Selv. (www.epeat.net)
EnergyStar 5,0 (kun pa bestemte modeller)
Emballage 100 9% genbrugelig
Specifikke stoffer PVC BFR-fri hus
[ Overholdelse ogstandarder |
Myndighedernes CE Mark, FCC Class B, GOAST, SEMKO, TCO Certified, UL/cUL, BSMI,
godkendelser 1S09241-307, Energy star 5.0
|Kabinee ]
Farve Sort
Finish Skinnende/Struktur

© Bemarkning

N

. EPEAT Guld og Selv er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net for
registreringsstatus i dit land.

Disse data kan eendres uden varsel. Ga til www.philips.com/support for at hente den seneste version
af brochuren.
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4.1 Oplasning og forudindstillede funktioner

E Maksimal oplasning

1680 x 1050 ved 60 Hz (analogt input)
1680 x 1050 ved 60 Hz (digital indgang)

E1 Anbefalet oplasning

1680 x 1050 ved 60 Hz (digital indgang)

[Vifrekv. (<H)[ Oplosning [ L frekv. (Hz) |
31,469 640x350 70,086
31,469 720x400 70,086
31469 640x480 59,940
35,000 640x480 67,000
37,500 640x480 75,000
35156 800x600 56,250
37,879 800x600 60,317
46,875 800x600 75,000
48,363 1024x768 60,004
60,023 1024x768 75,029
63,981 1280x1024 60,020
79,976 1280x1024 75,025
55469 1440x900 59,901
55,935 1440x900 59,887
70,635 1440x900 74,984
65,290 1680x1050 60,000
82,306 1680x1050 74,892

© Bemarkning

Bemaerk, at skeermen fungerer bedst med den
indbyggede oplasning pa 1680 x 1050 ved 60 Hz.
Folg den anbefalede oplasning for at opna den
bedste billedkvalitet.



5. Stremstyring

5.1 Automatisk energibesparelse

Huvis der er installeret et skeermkort eller software
pa pc'en, der er i overensstemmelse med

VESA DPM, kan skaermen automatisk nedsaette
stremforbruget, nar den ikke bruges. Nar input fra
tastatur, mus eller anden input-enhed registreres,
"vagner" skeermen automatisk igen. Nedenstdende
tabel viser denne automatiske energisparefunktions

stremforbrug og signalering:

220V3
VESA Video | V synk [ L synk Opbrugt strem Diodefarve
tilstand
Aktiv TIL Ja Ja < 22,63 W (typisk) Hvid
< 26,51 W (maks.)
Sovetilstand | FRA Nej Nej < 0,5W (typisk) Hvid
(Standby) (blinker)
Kontakt Fra | FRA - - < 0,5W (typisk) FRA
220V3A
VESA Video | V synk [ L synk Opbrugt strem Diodefarve
tilstand
Aktiv TIL Ja Ja <2141 W (typisk) Hvid
<319 W (maks.)
Sovetilstand | FRA | Nej Nej < 0,5W (typisk) Hvid
(Standby) (blinker)
Kontakt Fra | FRA - - <05W (typisk) FRA
220V3L
VESA Video | V synk [ L synk Opbrugt strem Diodefarve
tilstand
Aktiv TIL Ja Ja < 19,59 W (typisk) Hvid
< 2415W (maks.)
Sovetilstand | FRA Nej Nej < 0,5W (typisk) Hvid
(Standby) (blinker)
Kontakt Fra | FRA - - <05W (typisk) FRA

21

220V3LA

VESA Video | V synk | L synk Opbrugt stram Diodefarve
tilstand
Aktiv TL | R Ja | <1854 W (typisk) Hvid
< 28,03 W (maks.)
Sovetilstand | FRA | Nej Nej < 0,5W (typisk) Hvid
(Standby) (blinker)
Kontakt Fra | FRA - - < 0,5W (typisk) FRA

Folgende opsatning bruges til at mdle skeermens
stremforbrug.

Indbygget oplasning: 1680 x 1050

Kontrast: 50%

Lysstyrke: 250 nits

Farvetemperatur: 6500k med fuldt, hvidt menster

© Bemarkning
Disse data kan andres uden varsel.



6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!
=
CERTIFIED ensures that your display is
designed, manufactured and tested
according to some of the strictest quality and
environmental requirements in the world. This
makes for a high performance product, designed
with the user in focus that also minimizes the
impact on the climate and our natural
environment.

The display you have just purchased
carries the TCO Certified label. This

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality is
tested to ensure top performance and reduce
sight and strain problems. Important parameters
are luminance, contrast, resolution, black level,
gamma curve, colour and luminance uniformity
and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

Very low energy consumption both in on- and
standby mode minimize climate impact
Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and heavy
metals such as cadmium, mercury and lead
(RoHS compliance)

Both product and product packaging is prepared
for recycling

The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and ITmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Q&' Environmental Assessment Tool)
0 program evaluates computer
desktops, laptops, and monitors
based on 57 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following

standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment)

*  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)

*  EN55024:1998+A1:2001+A2:2003 (Immunity

requirement of Information Technology
Equipment)

»  EN61000-3-2:2006 (Limits for Harmonic
Current Emission)

*  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable

*  2006/95/EC (Low Voltage Directive)

» 2004/108/EC (EMC Directive)

» 2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

* 1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

«  GS EK1-2000:2009 (GS mark requirement)

»  prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

* MPR-Il (MPR:1990:8/1990:10 Low Frequency

Electric and Magnetic fields)

TCO certified (Requirement for Environment

Labeling of Ergonomics, Energy, Ecology and

Emission, TCO: Swedish Confederation of

Professional Employees) for TCO versions

Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR® guidelines
for energy efficiency.

4

ENERGY STAR

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

e

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de facon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

&tre décelé en fermant I'équipement, puis en
le remettant en fonction, I'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre I'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as describad in EN 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following appliss to
davicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of the
davics is obliged to take all stape necessary to remove sources of infarfersnce o tela-
communication or other devicss.

Pulmdnan[nutypmémﬁﬂm poditade uvadeno, Ze spadé do do ffidy A podle EN 55022,

spada automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-Ii k rudan( telekomunikatnich nebo
Pnych zafizeni je ufvatel povinmen provést takowvd opatfgnl, aby reSeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

HAZHARESIE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine bauartgleiche

eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast waéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

China RoHS

(A

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter pa
fladskerme

Philips tilstraeber at levere produkter af den hgjeste
kvalitet.Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udferer en
streng kvalitetskontrol. En gang imellem er defekte
pixler eller sub-pixler pd TFT skeermpaneler dog
uundgaelige. Ingen producent kan garantere,

at alle paneler vil vaere fri for pixeldefekter,

men Philips garanterer, at enhver skeerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For

at vaere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa

et TFT skeermpanel overskride disse acceptable
niveauer: For eksempel ma hgjst 0,0004% af sub-
pixlerne pa en skaerm veere defekte. Desuden
seetter Philips endnu hgjere kvalitetsnormer for
visse typer eller kombinationer af pixeldefekter,
derer mere generende end andre. Denne
pixelpolitik gzelder i hele verden.

subpixel subpixel

oy
il 5

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primzrfarverne red, gren og bla.
Nar mange pixler szettes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser, fremstar
de farvede sub-pixler tilsammen som enkelt hvid
pixel. Hvis de alle er merke, fremstar de tre farvede
sub-pixler tilsammen som en enkelt sort pixel.
Andre kombinationer af oplyste og merke sub-
pixler fremstar som enkelte pixler i andre farver

subpixel

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa skeermen
pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et markt
megnster. Der er felgende typer defekte lyse
prikker:

En teend red, gren eller bld sub-pixel

I @

To sammenliggende tendte sub-pixler:
Rad + Bla = Lilla

Red + Gregn = Gul

Grgn + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid pixel)
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€& Bemarkning

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end de
omkringliggende prikker.

Defekte mgrke prikker

Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er mgrke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et merkt
meanster. Der er felgende typer defekte mearke

prikker:

Textliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan vaere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT skeermpanel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,

der overskrider de tolerancer, der er gengivet i
folgende tabeller

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende teendte sub-pixler 1
3 sammenliggende taendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter® >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre
2 sammenliggende mgrke sub-pixler 2 eller ferre
3 sammenliggende marke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre

SAMLEDE DOT-DEFEKTER

Samlede bright- eller black dot-defekter af alle typer

ACCEPTABELT NIVEAU
5 eller faerre

=] Bemarkning

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO09241-307 (ISO9241-307: Testmetoder for ergonomisk
krav, analyse og overensstemmelse for elektroniske skaerme til fremvisning)



7.2 Kundeservice og garanti

Kundeservice og garanti

For oplysninger om garantideekning og geeldende stettekrav i dit omrdde, bedes du besgge www.philips.
com/support. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Austria Siemens I&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Germany Siemens &S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tIf
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
E—_— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Ejg:i;fegm NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
et NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tif
Argentina Vermont 0800 3330 856
Brazil Vermont 0800-7254101

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tIf
Canada Supercom Supercom (800) 479-6696
USA TOS Teleplan (877) 835-1838

Kontaktoplysninger til Kina:

Kina

Kundeservice tlf: 4008 800 008




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tIf
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | 1. i Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
T . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d}strlbutor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab {5 AL SHAHD COMPUTER LLC {00971 4 2276525
Emirates
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
S +84 5113.562666 Can tho Province
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan klares
af brugeren selv. Hvis problemet stadig er der; efter
at du har provet disse lasninger, skal du kontakte
Philips's Kundeservice.

E Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller; at el-ledningen er anbragt i
stikkontakten og bag pa skarmen.

* Kontroller ferst, at stremkontakten foran pa
skeermen er i OFF (FRA) position og tryk den
derefter i ON (TIL) position.

Intet billede (stremdiode blinker hvidt)

*  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt forbundet
til computeren.

* kontroller, at der ikke er nogen bgjede stikben
i signalkablets tilslutningsende. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan vaere aktiveret

Skaerm siger

Attention

Check cable connection

» Kontroller, at signalkablet er korrekt forbundet
til computeren. (Se ogsa Hurtig start-
vejledningen).

* Tjek, om skeermkablets stikben er bgjede.

* Kontroller, at der er teendt for computeren.
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AUTO (AUTOM.)-knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

€ Bemzrkning
Den automatiske funktion er ikke ngdvendig i DVI
digital-tilstand.

Synlige tegn pa rog eller gnister

*  Forsgg ikke at fejlfinde

*  Treek straks skaermens stik ud af stikkontakten

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

Bl Billeddannelses-problemer

Billedet er ikke centreret

* Justér billedets position med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Billede vibrerer pa skermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.



Vandret flimren

“

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

» Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i USD hovedmenuen. Den kan
kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for merkt
* Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede",
"indbraendingsbillede" eller "spagelsesbillede”,
efter at der er slukket for stremmen

*  Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan forarsage,
at det "braendes fast” pa skaermen, dvs. de
sakaldte “spogelsesbilleder’ pa din skaerm.
"Fastbreending” og "'spegelsesbilleder” er
velkendte faenomener inden for skeermpanel-
teknologien. | de fleste tilfeelde forsvinder
"indbreending" eller "efterbillede” eller
"spogelsesbillede” gradvist, efter at strammen
er slaet fra.

*  Serg altid for at aktivere en pauseskarm, der
bevager sig, nar skaermen efterlades uden at
blive anvendt.

* Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skarmen viser indhold, der ikke skifter:

* Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og "‘spagelsesbilleder” ikke
og kan €j heller fiernes ved reparation.
Ovennavnte skader er ikke deekket af
garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret

* Indstil pc'ens skaeermoplasning som skaermens
anbefalede, native oplasning.
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Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag. Se
politikken om pixels for yderligere oplysninger.

"Teendt"-lyset er for kraftigt. Det forstyrrer
* Du kan justere “Taendt"-lyset med Stremdiode

i OSD-menuerne.

For yderligere hjelp, se venligst Forbruger-
informationscentre-listen og kontakt Philips's
Kundeservice.



8.2 FAQ for SmartControl Lite

SP1.

Sv.:

SP2.

Sv.:

SP3.

Sv.:

Jeg har udskiftet skaermen pé en pc

til en anden skarm, og nu fungerer
SmartControl Lite ikke leengere. Hvad skal
jeg gore!

Genstart din pc og se, om SmartControl
Lite fungerer nu. Eller skal du afinstallere og
geninstallere SmartControl Lite for at sikre,
at den korrekte driver er installeret.

SmartControl Lite fungerede fint tidligere,
men nu virker programmet ikke langere.
Hvad skal jeg gore?

Hvis nogle af de falgende handlinger har

veeret udfert, skal skeermdriveren maske

geninstalleres.

* Videografikadapter er blevet udskiftet
med en anden

* Opdater videodriver

Aktiviteter i OS som f.eks. servicepakke

eller programrettelse

* Opdater Windows og opdater skarm-
og/eller videodriver

* Windows blev startet med skaermens
strem sldet fra eller afbrudt.
For at finde ud af det, skal du klikke
pa "Denne Computer" og derefter pa
Egenskaber -> Hardware ->Enhedsstyrer.
Huvis du ser "Plug & Play skeerm” under
Skeerm, skal du geninstallere. Afinstallér
SmartControl Lite og geninstallér det.

Efter installation af SmartControl Lite sker
der ingenting, selv om jeg klikker pa fanen
SmartControl Lite og venter, eller der
vises en fejlmeddelelse. Hvorfor?

Det skyldes muligvis, at din grafiske adapter
ikke er kompatibel med SmartControl Lite.
Hvis grafikadapteren er en af ovennavnte
meerker; skal du preve at downloade den
mest opdaterede grafikadapterdriver fra
det pageldende firmas ? websted. Installer
driveren. Afinstallér SmartControl Lite og
geninstallér det igen.
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SP4.

Sv.:

SP5.

Sv.:

Huvis det stadig ikke virker, er vi bange for,
at grafikadapteren ikke understgttes. Ga til
Philips websted og kontrollér, om der findes
en nyere driver for SmartControl Lite .

Nar jeg klikker pa "Product Information"
("Produktinformation"), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan veare, at din grafikkortadapterdriver
ikke er den mest opdaterede version, som
fuldt ud understetter DCC/CI greenseflade.
Prev at downloade den mest opdaterede
grafikkortadapterdriver fra det pageeldende
firmas ? websted. Installer driveren.
Afinstallér SmartControl Lite og geninstallér
det igen.

Attention

Theft Deterence enabled

Jeg har glemt min PIN-kode til Theft
Deterence (Anti-tyveri) funktionen. Hvad
gor jeg!

Philips servicecenter forbeholder sig retten
til at bede om legitimation og godkendelse
for at kunne etablere skeermens ejer:

Bemaerk, at tyverisikringsfunktionen er en
nyttig funktion, der falger med som gratis
ekstraudstyr. Ansvaret for styring af PIN-
koder ligger alene hos den individuelle
bruger eller organisationen, der opseetter
dem.

Hvis PIN-koden glemmes, kan Philips
servicecenter nulstille den for et mindre
gebyr, efter verificering af ejerskab. Bemaerk,
at denne aktivitet ikke er deekket af standard
garantien.



8.3 Generelle FAQ SP4:

SP1:

Sv.:

SP2:

Sv.:

SP3:

Sv.:

Sw.:
Hvad skal jeg gore, hvis skermen under
installationen viser "Cannot display this
video mode” (”Kan ikke vise denne
videotilstand’)?

Den anbefalede oplgsning for denne skaerm:

1680x1050 ved 60Hz. SP5:

* Frakobl alle kabler og forbind derefter
pc'en til skaermen, som du brugte fer. Sv.:

* | Windows Start Menu, vaelg Indstillinger/
Kontrolpanel. | Kontrolpanel vinduet veelg
Skaerm-ikonen. | Egenskaber for Skeerm
vinduet veelg "Indstillinger” fanebladet.
Under indstillinger, skub skyderen til
1680x1050 pixler.

+ Abn "Avanceret” og indstil Sv.:
opdateringshastigheden pa 60Hz og klik
derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 for at bekreefte, at pc'en er
indstillet pa 1680x1050 ved 60Hz.

* Luk for computeren, frakobl den gamle

skaerm og genforbind Philips skaermen. SP7:

* Tand for skeermen og derefter for pc'en.
Sv.:

Hvad ger den anbefalede
opdateringshastighed for skermen?

Den anbefalede opdateringshastighed for
skaeerme er 60Hz. | tilfelde af forstyrrelser
pa skeermen skal du seette den op til 75Hz
og se, om dette flerner forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-rom’en?
Hvordan installerer jeg driverne (.inf og
.icm)?

Dette er skaermens driverfiler: Installer
driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om
skaermdrivere (.inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen fgrste
gang. Indszet (medfelgende cd-rom) i pakken
i henhold til anvisningerne. Skaermdrivere
(iinf og .icm filer) installeres automatisk.
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SPé:

Hvordan justerer jeg oplgsningen?

Skaermkortet/grafikdriveren og skaermen
bestemmer sammen oplasningerne til
radighed. Du kan veelge den gnskede
opl@sning "Egenskaber for Skaerm™ i
Windows® kontrolpanelet.

Hvad, hvis jeg "farer vild”, mens jeg
justerer skarmen?

Sa skal du blot trykke pa OK og derefter
valge "Reset” ("Tilbagestil”) for at ga tilbage
til de oprindelige fabriksindstillinger.

Er skeermen modstandsdygtig overfor
ridser?

Det anbefales generelt ikke at udsette
skaermens overflade for kraftige sted. Den
er beskyttet mod skarpe og stumpe ting.
Nar du handterer skeermen sa pas pa ikke
at trykke for kraftigt pa skeermens overflade.
Det kan pavirke garantibetingelserne.

Hvordan renger jeg skermens overflade?

Til normal renggring skal du blot anvende
en ren, bled klud. Til kraftigere renggring
skal du bruge isopropylalkohol. Brug ikke
andre oplgsningsmidler sdsom ethylalkohol,
ethanol, acetone, hexan osv.



SP8: Kan jeg &ndre skermens farveindstilling?

Sv.:  Ja, du kan @ndre farveindstillingen via OSD

pa felgende made:

* Tryk pa "OK" for at vise OSD (On
Screen Display)-menuen

* Tryk pa "Ned-pil” for at veelge indstillingen
"Color"” (Farve), og tryk derefter pa "OK"
for at angive farveindstillingen. Der er tre
indstillinger, som vist nedenfor.

1. Color Temperature (Farvetemperatur)
- De 2 indstillinger er 6500K og 9300K.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (feks.
digitale kameraer, skeerme printere,
skannere osv.)

3. Brugerdefiner - brugeren kan valge
sin foretrukne farveindstilling ved at
indstille den rade, grenne og bla farve.

& Bemark

Et mal for farven pa lys, der udstrales fra et objekt,
mens det opvarmes. Dette mal udtrykkes pa en
absolut skala (kelvingrader). Lavere kelvingrader
sasom 2.004K er rede, hgjere temperaturer sdsom
9.300K er bla. Neutral temperatur, 6.504K, er hvid.

SP9: Kan jeg forbinde min skaerm til enhver pc,
arbejdsstation eller Mac?

Sv..  Ja.Alle Philips skaeerme er fuldt kompatible
med standard pc'er, Mac'er og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler; at
du kontakter Philips salgsrepreesentant for
yderligere oplysninger.

SP10: Er Philips skeerme ”Plug & Play”?

Sv..  Ja, skeermene er "Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX,
Linux.

SP11: Hvad er "billedklebning” eller
”billedindbraending” eller "efterbillede”
eller "spogelsesbillede” pa skaerme?

Sv.. Uafbrudt visning af stille eller statiske billeder
over en leengere periode kan fordrsage,
at det ""breendes fast” pa skaermen, dvs. de
sakaldte “spggelsesbilleder” pa din skaerm.
"Fastbreending” og "spegelsesbilleder”
er velkendte faanomener inden for
skeermpanel-teknologien. | de fleste tilfelde
forsvinder "indbranding” eller "efterbillede”
eller "spogelsesbillede” gradvist, efter at
strommen er slaet fra.
Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt.
Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skaermen viser indhold, der ikke skifter:

) Advarsel

Alvorlig "indbreending”- eller "efterbillede’- eller
"spagelsesbillede”-symptomer forsvinder ikke og
kan ikke repareres. Ovennavnte skader er ikke
daekket af garantien.

SP12: Hvorfor viser skarmen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv..  Skarmen arbejder bedst med sin native
oplgsning pa 1680x1050 ved 60Hz.
Brug denne oplgsning for at opna det
bedste billede.
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